Welcome to Research Insight®. This user guide will show you everything you need to know to access and utilize the wealth of information available from Research Insight®.

The Research Insight® program is a database on the Mason School of Business network that may be accessed by using one of the network computers in the McLeod Business Library in Alan B. Miller Hall.

Mason School of Business graduate students, undergraduate students with a Business major, faculty and staff may also access this program through the Mason School of Business network.

Introduction

Standard & Poor’s Research Insight® offers detailed financial data, company reports, performance graphs, and other documents. You may access more than 160 pre-defined reports and company performance charts including financial statements, market summaries, forecasts, and total returns, sales growth and price and earnings momentum.

The COMPUSTAT® (North America) database contains up to 20 years of annual, 12 years of quarterly, seven years of business and geographic segment, and 240 months of stock prices and dividend data. With fundamental financial and market data for more than 10,300 U.S. and Canadian companies, the North America database allows you to analyze the domestic market. The database also contains data for more than 7,600 inactive companies that no longer file with the Securities and Exchange Commission due to a merger, liquidation, bankruptcy, etc.

The COMPUSTAT® (Classic) database is an as-reported historical database that provides non-restated, quarterly COMPUSTAT® data as it was originally collected by Standard & Poor’s.

With Research Insight® you may:

- Prepare reports such as company financials, stock performances and company-to-industry comparisons.
- Perform credit analyses to evaluate credit risk, lending situations, cash management and industry trends.
- Analyze the financial condition of companies.
- Evaluate a company’s vulnerability to merger or acquisition.
- Evaluate the performance of strategic business units based on contribution to the corporate performance, relative strength and industry attractiveness.
# Table of Contents

- Introduction ............................................................................................................................... 1
- Table of Contents ...................................................................................................................... 2
- The *Research Insight*® Window ............................................................................................ 3
- The Welcome Screen ................................................................................................................ 5
  - Research Assistant .............................................................................................................. 6
  - Report Assistant ................................................................................................................. 12
  - Chart Assistant .................................................................................................................... 16
  - Company Highlights ........................................................................................................... 21
  - Library ................................................................................................................................. 27
  - Open Screen ......................................................................................................................... 29
  - Open Report ......................................................................................................................... 31
  - Open Chart ......................................................................................................................... 33
  - Open Set .............................................................................................................................. 35
- The Menu Bar ........................................................................................................................... 37
  - File ..................................................................................................................................... 37
  - Edit ..................................................................................................................................... 38
  - View ................................................................................................................................... 41
  - Databases ............................................................................................................................. 42
  - Tools ................................................................................................................................... 44
  - Styles ................................................................................................................................. 45
    - Changing the Style in Research Insight® ....................................................................... 46
  - Window ............................................................................................................................... 47
  - Help .................................................................................................................................. 48
- Definitions ............................................................................................................................... 51
  - Company References .......................................................................................................... 51
  - Concepts ............................................................................................................................... 51
  - Functions ............................................................................................................................... 51
  - Items .................................................................................................................................. 51
  - Predefined Sets ..................................................................................................................... 51
  - Sets ..................................................................................................................................... 52
  - Time Period References ....................................................................................................... 53
- Using the Research Insight Add-In for Excel ........................................................................... 54
  - Finding the Welcome to Research Insight Screen .............................................................. 55
  - Research Insight Assistants and Predefined Reports, Charts and Templates ............... 55
    - Open Templates ............................................................................................................... 56
  - Other Functions ..................................................................................................................... 58
  - Notes .................................................................................................................................. 58
The Research Insight® Window

The Research Insight® window consists of six sections. You may enlarge this window to fill the entire screen by clicking on the small box, between the “-” and “x” boxes, in the upper right corner of the screen. The sections of the screen are:

(1) The Research Insight® title bar.
(3) The third section is the Main toolbar of icons that stretches across the window just below the Menu Bar.
(4) The fourth section is the Research Insight® toolbar, which is the vertical row of icons along the left side of the window.
(5) The fifth section is the large display area where the result of your analysis is presented. This section also includes a set of boxes just below the Main toolbar icons. These boxes are grayed out until information is presented in the display area that has data that may be modified.
(6) The sixth section is the Status Bar, which is located at the bottom of the screen.

The icons displayed on the left side of the window (Research Insight® toolbar) are the same as those from the Welcome screen. The Library icon, which is included with those on the Welcome screen, is in the Main toolbar below the Menu Bar.
Note: In Research Insight® COMPUSTAT®, the abbreviation CS refers to the COMPUSTAT® (North America) database.

Note: Selecting Help from the Menu Bar opens a drop-down menu that offers a wide variety of help selections. For more information on the Help menu go to page 48.
The Welcome Screen

When Research Insight® first opens, you are presented with a Welcome screen that offers nine options to begin your analysis. These options are:

Research Assistant – Allows you to define your screening criteria, then develop custom reports and charts, or access predefined reports or charts.

Report Assistant – Allows you to develop custom reports, then define your screening criteria.

Chart Assistant – Allows you to develop custom charts, then define your screening criteria.

Company Highlights – Allows you to run a Company Highlights report for one or more companies.

Library – Allows you to retrieve information from textual databases.

Open Screen – Allows you to open pre-defined screens, or begin developing a new screen.

Open Report – Allows you to open pre-defined reports, or begin building a new report.

Open Chart – Allows you to open pre-defined charts, or begin building a new chart.

Open Set – Allows you to open pre-defined sets, or begin developing a new set.

To choose an option, click on the icon of the function you want to perform. If you do not want to use any of these options, you may click on the Close button and this screen will disappear and you will be presented with the basic Research Insight® window.

Note: This screen may be accessed while using Research Insight® by clicking the Welcome icon on the Main toolbar or by clicking on Help on the Menu Bar and selecting Welcome to Research Insight from the drop-down menu.
Research Assistant

Research Insight’s Research Assistant gives you a powerful tool for screening the COMPUSTAT® (North America) database for companies, industries and economic sectors that meet a wide range of criteria. You can run predefined screens built into the program or create your own screens. Your screening criteria can include individual data items, concepts or formulas. The companies that pass your screen can be saved in a set so you can use the data in future analyses.

The Research Assistant allows you to develop the criteria you need to identify the companies you want to include in your research. Once you have chosen the companies or developed the screen you want to use Research Assistant leads you to Report Assistant, Chart Assistant, or Company Highlights where you can use the screen you developed to present information on the companies in your set. You are also given the choice to go directly to Open Report or Open Chart to use predefined reports and charts to display data from your set.

There are a number of ways to start Research Assistant. You may:

- Click on the Research Assistant icon on the Welcome screen,
- Click on the Research Assistant icon on the vertical Research Insight® toolbar on the Research Insight® window, or
- Click on Research Assistant in the Tools drop-down menu on the Menu Bar on the Research Insight® window.

A. Once the Research Assistant is started, you are presented with the Research Assistant – Step 1 (Money Management) window.

Note: The “Money Management” in the window title refers to the Style being used in your research. The Style affects the way Research Insight® screens companies for your sets and the data that is displayed in the reports and charts that are produced. For more information concerning Style please go to page 45.
1. The upper left corner of this window has the Companies box with a Look Up button next to it. You may enter one or more company ticker symbols in this box and perform your research on these companies. If you do not know the ticker symbols for the companies you want to use click on the Look Up button.

   • This opens the Look Up window. This window is similar to the Look Up window that is opened when Look Up is selected from the Tools drop-down menu on the Menu Bar except this window only has a tab for Companies instead of the four tabs of the other window (from the Tools drop-down menu).
   
   • You may use the Look Up window to search for and select companies for your research.
   
   • Click on the Paste button for each company you want to include in your research.
   
   • When you have finished selecting companies, click on Close to return to the Research Assistant window.

2. After you have a company or companies listed in the Companies box, the box below this box, the Find Similar Companies box, is activated (it was grayed out when the Research Assistant window first opened). You may select whether or not to include similar companies according to the criteria offered (e.g., SIC, Country, etc.) by highlighting the item you want. You may select “Don’t find similar companies,” which is the default setting.

3. Next is the Period Selection box that has Current Period as the default selection. This cannot be changed.

4. Below this box is a group of four buttons Open Screen, Classic View, Clear and Reset.

   • Clicking on the Open Screen button opens the File Open window, which is similar to the window you see when you select Open from the File drop-down menu on the Menu Bar. You may select various saved screens to use for your research.

   • Clicking on the Classic View button changes the Research Assistant window to the Research Assistant – Step 1 – Classic View window. This presents the data in a spreadsheet format. The various buttons on this page are similar in function to the
Research Assistant window you started with.

To return to the original window, click on the Screen View button in the lower left corner.

- The Clear button returns the Research Assistant window to its original state, removing any selections you may have made. This includes the Companies box, the Initial Set box and the Indicators area.

- The Reset button returns all areas to the beginning state except the Companies box.

5. In the bottom left corner of the Research Assistant window is the Save Screen button group.

These buttons, Save and Save As, open the Save As window where you may save the screen you are using so you may use it for future research.

6. The upper right corner has the Initial Set box with the Change Set button next to it. The default setting is for the box to have “(none)” in it.

- To select a set click on the Change Set button. This opens the Initial Set window. This window has a Set data field with a Look Up button next to it.

- You may enter the set you want to use by typing it into the data field. If you do not know the exact name of the set click on the Look Up button.
• This opens the Look Up window with the Sets tab as the only tab. You may select the Sets Category and then the individual set in the Select Sets box.

• When you are finished click on the Paste button to move the set to the Initial Set window.

• Click on the Close button to return to the Initial Set window.

• The set you selected should be in the Set box.

• Click on the OK button to close the Initial Set window and move the set to the Initial Set box in the Research Assistant window.

7. Below the Initial Set box is the Indicators area. This area consists of a set of more than 25 tabs (e.g., Company Specifics, Valuation, etc.).

   Note: The Indicator Groups and Indicators affect the way Research Insight® screens its databases in selecting companies for your research. Different Indicator Groups and Indicators are available by selecting different Styles. For more information on Style please go to page 45.

   Each tab has its own set of indicators, which are displayed as each tab is clicked on.

   The tabs scroll from side to side by clicking on the left and right arrow buttons beside the tab names.

   You may select the indicators you want to use by clicking on the check box next to the indicator.

   As each indicator is selected the two boxes next to it are activated.

   • Each box has a drop-down menu to select terms.

   • The first menu contains mathematical symbols (i.e., <, >, =, etc.) and the second menu contains terms pertinent to the indicator.

   You may select indicators from more than one tab.

   To view a description of an indicator, click on the indicator with the RIGHT mouse button. This will open the Item Definition or Formula Definition window.
• This window provides some information about the indicator. Most Item Definition windows include a Definition button.

• Clicking on the Definition button opens the COMPUSTAT North America Data and Reference window, which is part of the Help function.

The indicators may be customized by clicking on the Customize button. This opens the Custom Indicator Groups window.

This window allows you to modify the indicators and how they are presented in the Research Assistant window.

An Indicator may be eliminated from the display by removing the check from the check box by the indicator.

When an Indicator is selected by highlighting it in the Indicator Groups box the individual Indicator Items are displayed in the Indicator Items box. These may be added or removed from the display by clicking on the check box next to the item.

The buttons below the Indicator Groups and Indicator Items boxes allow you to add new indicators, edit indicators, delete indicators or move the indicators up or down the list.

When you are finished modifying the indicators click on the OK button to return to the Research Assistant window. The changes you made will be reflected in the display in the Indicators area.

8. When you have finished selecting the companies you are interested in researching and making any modifications in the search criteria, click on the Next button.
B. This will take you to the Research Assistant – Step 2 (Money Management) window.

1. This window allows you to fine-tune your list of companies. You may add or remove companies from the list or change the way the list is displayed (Names or Tickers). This list, created using the specific criteria you selected will be used as the basis of your research. You may create a variety of reports or charts or develop in-depth company information.

2. After you have made any changes to your list of companies, click on the Next button.

C. This will take you to the Research Assistant – Step 3 (Money Management) window.

This window gives you a number of choices. You may go to the Report Assistant, Chart Assistant, Company Highlights page or open predefined reports or charts. You may also elect to finish this project and return to the Research Insight® window.

Clicking on Report Assistant and the Next button will take you to the Report Assistant – Step 1 (Money Management) window. See page 12.

Clicking on Chart Assistant and the Next button will take you to the Chart Assistant – Step 1 (Money Management) window. See page 16.

Clicking on Open Report and the Next button will take you to the File Open (Money Management) window. See page 31.

Clicking on Open Chart and the Next button will take you to the File Open (Money Management) window. See page 33.

Clicking on Company Highlights and the Finish button will finish the search on the companies you selected and provide a Company Highlights report in the Research Insight® window display area.

Clicking on Finish and the Finish button will return you to the Research Insight® window after prompting you to save your changes. No functions will be performed on your list of companies.
Report Assistant

Report Assistant allows you to use the sets or screens you developed using Research Assistant to run a wide variety of reports to display information and data contained in the COMPUSTAT® (North America) database.

There are a number of ways to start Report Assistant. You may:

- Click on the Report Assistant icon on the Welcome screen,
- Click on the Report Assistant icon on the vertical Research Insight® toolbar on the Research Insight® window, or
- Click on Report Assistant in the Tools drop-down menu on the Menu Bar on the Research Insight® window.

A. Once Report Assistant is started, you are presented with the Report Assistant – Step 1 (Money Management) window.

Note: The “Money Management” in the window title refers to the Style being used in your research. The Style affects the way Research Insight® screens companies for your sets and the data that is displayed in the reports and charts that are produced. For more information concerning Style please go to page 45.

This window gives you a graphical example of how the report will be arranged. This display changes as you exercise the various options of how to arrange your data.

There are three groups of options to arrange the data in your report.

- The first group is Current Time Period. It contains two options Items vs Companies and Companies vs Items. Each option has a radio button next to it.
Click the radio button for the option you want to use. **Items vs Companies** is the default selection.

Selecting **Companies vs Items** activates the Company Count box below the sample report. Using this box, you may select the number of companies to display in your report.

- The second group is **Historical Analysis**. It contains three options **Items vs Companies**, **Items vs Time for a Company**, and **Time vs Items for a Company**. Click the radio button next to the option you want to select. The display changes for each selection.

- The last group contains just one option. It is **Blank Report**. Selecting this option will give you a blank screen in the *Research Insight*® window display area.

When you have selected the option you want to use click on the **Next** button.

**B.** This opens the *Report Assistant – Step 2 (Money Management)* window. This window has four boxes with options you may select to construct your report.

1. The first box is **Item Groups**. It has nine Item Groups listed.

   **Note:** The Item Groups and Items affect the data *Research Insight*® presents in the reports and charts resulting from your research. Different Item Groups and Items are available by selecting different Styles. For more information on Style please go to page 45.

   Included in this box is the **Customize** button. You may use this button to open the **Custom Item Groups** window. This window is used to modify the Item Groups displayed in the **Item Groups** box in the *Report Assistant* window.

   The **Item Groups** box on the **Custom Item Groups** window lists all the Item Groups available. There is a limit of nine groups maximum that can be displayed.

   Select the Item Groups you want to have displayed by clicking on the check box by the Item Group. As each item group is highlighted the items in that group are displayed in the **Items** box.
The items in either box may be modified, moved up or down the list, deleted or new items added by using the buttons below each box.

When you have finished making the changes you want click on the **OK** button to return to the *Report Assistant* window.

2. In the *Report Assistant* window, each time you highlight an Item Group the items contained in that group are displayed in the Items box.

As each Item in the Items box is highlighted its mnemonic is displayed in the data field below the box.

Beside this data field is the **Definition** button. If you want to see the definition of an Item click on the **Definition** button.

3. The items in this box may be moved into the Selected Items box by highlighting the items you want and clicking on the **Add** button.

All of the items in the Items box may be moved by clicking on the **Add All** button.

Items in the Selected Items box may be moved up or down or modified by using the buttons below the box.

4. Above the Selected Items box is the New Item box. You may use the data field in this box to create a new Item.

Clicking on the **Look Up** button beside the New Item box opens the *Look Up* window with two tabs – Items and Functions.

Any new Items you select will be added to the bottom of the list of Items in the Selected Items box of the Report Assistant – Step 2 window.

However, if you click in the New Item box to place the cursor in that box **before** you click on the **Look Up** button, any item you select in the Look Up window will be placed in the New Item box.

When there is an Item in the New Item box the down arrow button will be activated. Clicking on this button does one of two things.

- If the Item has no periodicity element the Item is moved into the Selected Items box.
- If the Item had a periodicity element the *Formula Periodicity* window is opened. In this window you may select the periodicity (i.e., Quarterly, Monthly, etc.) you want to use in your report.

When you have selected the periodicity you want click on the **OK** button to move the Item into the Selected Items box.
5. When you have finished making your selections and any modifications, click on the Finish button to complete your report.

C. The Finish button will give you one of two results.

1. If you were using Research Assistant to create your set of companies your report will be completed and displayed in the Research Insight® window display area.

2. If you started with Report Assistant, clicking the Finish button will open the Run Assistant (Money Manager) window.

Although the basic features of this window are similar to the Research Assistant – Step 1 (Money Management) window, you should go to page 21 in the Company Highlights section for detailed information on how to use the features in the Run Assistant window.

The Run Assistant window allows you to create a set or screen and select indicators.

Clicking OK in the Run Assistant window completes your report and displays it in the Research Insight® window display area.

D. Once the report is displayed in the Research Insight® window display area you may alter the report by using the radio buttons in the Show box, located to the left of the display.

You may select Formula or Report. Clicking on the radio button next to your selection allows you to view the report (the default setting) or the formulas. The display changes as you make different selections.

E. When you are finished working with your report you may close it by clicking on the lower of the two “Xs” in the upper right corner.

This will prompt you to save your work. If you want to save it click on the Yes button.

This will open the Save As window. You must save the file to your personal disk.
Chart Assistant

Chart Assistant allows you to use the sets or screens you developed using Research Assistant to run a wide variety of charts to display information and data contained in the COMPUSTAT® (North America) database.

There are a number of ways to start Chart Assistant. You may:

- Click on the Chart Assistant icon on the Welcome screen,
- Click on the Chart Assistant icon on the vertical Research Insight® toolbar on the Research Insight® window, or
- Click on Chart Assistant in the Tools drop-down menu on the Menu Bar on the Research Insight® window.

A. Once Chart Assistant is started, you are presented with the Chart Assistant – Step 1 (Money Management) window.

   Note: The “Money Management” in the window title refers to the Style being used in your research. The Style affects the way Research Insight® screens companies for your sets and the data that is displayed in the reports and charts that are produced. For more information concerning Style please go to page 45.

This window gives you a graphical example of how the chart will look. The display changes as you select the various styles of charts available.

There are six types of charts, listed in the Chart Style box, you may choose from. They are Area; Bar; High, Low, Close; High, Low, Close, Volume; Line; and Pie.

There are three boxes across the lower section of the window. They are Companies per Chart,
Periods, and Time Reference. The various options in these boxes are either active or grayed out depending on which type of chart is selected. For example, the options in Time Reference are grayed out until High, Low, Close or High, Low, Close, Volume is selected in the Chart Style box.

When you have made your selections, click on the Next button. **Note:** Depending on the chart type selected, you may skip to Step 3, paragraph C below.

B. This opens the Chart Assistant – Step 2 (Money Management) window. This window has three boxes with options you may select to construct your chart.

1. The first box is Item Groups. It has nine Item Groups listed.

   **Note:** The Item Groups and Items affect the data Research Insight® presents in the reports and charts resulting from your research. Different Item Groups and Items are available by selecting different Styles. For more information on Style please go to page 45.

   Included in this box is the Customize button. You may use this button to open the Custom Item Groups window. This window is used to modify the Item Groups displayed in the Item Groups box.

   The Item Groups box on the Custom Item Groups window lists all the Item Groups available. There is a limit of nine groups maximum that can be displayed.

   Select the Item Groups you want to have displayed by clicking on the check box by the Item Group you want. As each item group is highlighted the items in that group are displayed in the Items box.

   The items in either box may be modified, moved up or down the list, deleted or new items added by using the buttons below each box.

   When you have finished making the changes you want, click on the OK button to return to the Chart Assistant window.

2. In the Chart Assistant window, each time you highlight an Item Group the items...
contained in that group are displayed in the **Items** box.

As each Item in the **Items** box is highlighted its mnemonic is displayed in the data field below the box.

Beside this data field is the **Definition** button. If you want to see the definition of an Item click on the **Definition** button.

3. The items in the **Items** box may be moved into the **Selected Items** box by highlighting the items you want and clicking on the **Add** button.

   All of the items in the **Items** box may be moved by clicking on the **Add All** button.

   Items in the **Selected Items** box may be moved up or down or modified by using the buttons below the box.

4. Above the **Selected Items** box is the **New Item** box. You may use the data field in this box to create a new Item.

   Clicking on the **Look Up** button beside the **New Item** box opens the **Look Up** window with two tabs – Items and Functions.

   Any new Items you select will be added to the bottom of the list of Items in the **Selected Items** box.

   However, if you click in the **New Item** box to place the cursor in that box before you click on the **Look Up** button, any item you select will be placed in the **New Item** box.

   When there is an Item in the **New Item** box the down arrow button will be activated. Clicking on this button does one of two things.

   - If the Item has no periodicity element the Item is moved into the **Selected Items** box.

   - If the Item had a periodicity element the **Formula Periodicity** window is opened. In this window you may select the periodicity (i.e., Quarterly, Monthly, etc.) you want to use in your chart.

     When you have selected the periodicity you want click on the **OK** button to move the Item into the **Selected Items** box.

5. When you have finished making your selections and any modifications, click on the **Next** button.

C. This opens the **Chart Assistant – Step 3 (Money Management)** window. This window has two boxes with options you may select to construct your chart. The boxes are **Periods** and **Alignment**.
1. The **Periods** box allows you to select the beginning and ending periods for the chart. **Note**: In order to display historical data (data from previous periods) you must use a **negative number** (e.g., -1, -3, etc.) in the **Beginning Period** box.

2. The **Alignment** box allows you to select the alignment that will be used for all items in the chart. This is particularly useful if some of the items have differing or more than one periodicity. For example, you may select Monthly as the periodicity for all the Items in the chart so that all of the Items are charted using the same gauge.

When you have finished making your selections click on the **Finish** button.

D. The **Finish** button will give you one of two results.

1. If you were using Research Assistant to create your set of companies your chart will be completed and displayed in the **Research Insight®** window display area.

2. If you started with Chart Assistant, clicking the **Finish** button will open the **Run Assistant (Money Manager)** window. Although the basic features of this window are similar to the **Research Assistant – Step 1 (Money Management)** window, you should go to page 21 in the Company Highlights section for detailed information on how to use the features in this window.

The **Run Assistant** window allows you to create a set or screen and select indicators.

Clicking **OK** in the **Run Assistant** window completes your chart and displays it in the **Research Insight®** window display area.

E. The chart displayed in the **Research Insight®** window is the result of your
research and the selections you made. However, you still have more options available to you to change how the chart is displayed.

There is a row of buttons across the top of the display area that allow you to select a different type of chart (Area, Pie, Bar, etc.), make it 3-D, add vertical and horizontal lines, add headers, and change the chart properties.

There are two boxes to the left of the display area that allow you several more options.

1. The first box, Show, has four choices.

   You may select **Formula, Report, Chart**, or **Chart & Report**.

   Clicking on the radio button next to your selection allows you to view the chart, the report generating the chart, both the report and the chart or the formulas. The display changes as you make different selections.

2. The second box, Companies, has four buttons near the top and a box at the bottom. The box has all the companies you selected listed if you selected **One Company** in the Companies per Chart box in the Chart Assistant – Step 1 (Money Management) window. The chart for each company will be displayed one at a time.

   The top two buttons, **Name** and **Ticker**, allow you to have the companies listed by name or ticker.

   The next two buttons, **Prev** and **Next**, allow you to move up and down the list of companies.

F. When you are finished working with your chart you may close it by clicking on the lower of the two “Xs” in the upper right corner.

   This will prompt you to save your work. If you want to save it click on the **Yes** button.

   This will open the Save As window. You must save the file to your personal disk.
Company Highlights

Company Highlights allows you to develop sets or screens or use predefined sets and screens to open a standard report of information and data contained in the COMPUSTAT® (North America) database.

There are a number of ways to start Company Highlights. You may:

- Click on the Company Highlights icon on the Welcome screen,
- Click on the Company Highlights icon on the vertical Research Insight® toolbar on the Research Insight® window, or
- Click on Company Highlights in the Tools drop-down menu on the Menu Bar on the Research Insight® window.

A. Once Company Highlights is started, you are presented with the Run Assistant (Money Management) window. This window has four tabs across the top. The tabs are Screen, Set, Report Time Periods, and Screen – Classic View.

Note: The “Money Management” in the window title refers to the Style being used in your research. The Style affects the way Research Insight® screens companies for your sets and the data that is displayed in the reports and charts that are produced. For more information concerning Style please go to page 45.

1. The Screen tab is the default view you see when the window is first opened.

   a. The upper left corner of the Screen tab has the Companies box with a Look Up button next to it. You may enter one or more company ticker symbols in this box and perform your research on these companies.

   If you do not know the ticker symbols for the companies you want to use click on the Look Up button.
• This opens the Look Up window. This window is similar to the Look Up window that is opened when Look Up is selected from the Tools drop-down menu on the Menu Bar except this window only has a tab for Companies instead of the four tabs of the other window (from the Tools drop-down menu).

• You may use the Look Up window to search for and select companies for your research.

• Click on the Paste button for each company you want to include in your research.

• When you have finished selecting companies, click on Close to return to the Run Assistant window.

b. After you have a company or companies listed in the Companies box, the Find Similar Companies box is activated (it was grayed out when the Run Assistant window first opened). You may select whether or not to include similar companies according to the criteria offered (i.e., SIC, Country, etc.) by highlighting the item you want. You may select “Don’t find similar companies,” which is the default setting.

c. Next is the Period Selection box that has Current Period as the default selection. This cannot be changed.

d. Below this box is a group of four buttons Open Screen, Classic View, Clear and Reset.

• Clicking on the Open Screen button opens the File Open window, which is similar to the window you see when you select Open from the File drop-down menu on the Menu Bar. You may select various saved screens to use for your research.

• Clicking on the Classic View button changes the Run Assistant window to show the Screen – Classic View tab. This presents the data in a spreadsheet format. The various buttons on this page are similar in function to the Screen tab.

To return to the Screen tab, click on the Screen View button in the lower left corner or the Screen tab.

• The Clear button returns the Run Assistant window to its original state, removing any selections you may have made. This includes the Companies box, the Initial Set box and the Indicators area.

• The Reset button clears any indicator selections and sets in the Initial Set box you may have made without affecting the Companies box.
e. In the bottom left corner of the Research Assistant window is the Save Screen button group.

These buttons, Save and Save As, open the Save As window where you may save the screen you are using so you may use it for future research.

f. The upper right corner has the Initial Set box with the Change Set button next to it. The default setting is for the box to be grayed out.

To select a set click on the Change Set button. This opens the Initial Set window. This window has a Set box with a Look Up button next to it.

You may enter the set you want to use by typing it into the box. If you do not know the exact name of the set click on the Look Up button.

This opens the Look Up window with the Sets tab as the only tab. You may select the Sets Category and then the individual set in the Select Set box. When you are finished click on the Paste button to move the set to the Initial Set window.

Click on the Close button to return to the Initial Set window.

The set you selected should be in the Set box.

Click on the OK button to close the Initial Set window and move the set to the Initial Set data field in the Run Assistant window.

g. Below the Initial Set box is the Indicators area. This area consists of a set of more than 25 tabs (e.g., Population Particulars, Valuation, etc.). Each tab has its own set of indicators, which are displayed as each tab is clicked on. The tabs scroll from side to side by clicking on the left and right arrow buttons beside the tab names.

Note: The Indicator Groups and Indicators affect the way Research Insight® screens its databases in selecting companies for your research. Different Indicator Groups and Indicators are available by selecting different Styles. For more information on Style please go to page 45.
You may select the indicators you want to use by clicking on the check box next to the indicator.

As each indicator is selected the two boxes next to it are activated. Each box has a drop-down menu to select terms. The first menu contains mathematical symbols (i.e., <, >, =, etc.) and the second menu contains terms pertinent to the indicator.

You may select indicators from more than one tab.

To view a description of an indicator, click on the indicator with the RIGHT mouse button. This will open the Item Definition window.

- This window provides some information about the indicator. Most Item Definition windows include a Definition button.

- Clicking on the Definition button opens the COMPUSTAT (North America) Data and Reference window, which is part of the Help function.
The indicators may be customized by clicking on the **Customize** button. This opens the *Custom Indicator Groups* window.

This window allows you to modify the indicators and how they are presented in the *Run Assistant* window.

An Indicator may be eliminated from the display by removing the check from the check box by the indicator. When an Indicator is selected by highlighting it in the *Indicator Groups* box the individual Indicator Items are displayed in the *Indicator Items* box. These may be added or removed from the display by clicking on the check box next to the item.

The buttons below the *Indicator Groups* and *Indicator Items* boxes allow you to add new indicators, edit indicators, delete indicators or move the indicators up or down the list.

When you are finished modifying the indicators click on the **OK** button to return to the *Run Assistant* window. The changes you made will be reflected in the display in the Indicators area.

2. When you have finished selecting the companies you are interested in researching you may make more adjustments to the set by clicking on the **Set** tab.

This tab allows you to fine-tune your list of companies.

You may add or remove companies from the list or change the way the list is displayed (Names or Tickers).

3. Selecting the **Report Time Periods** tab allows you to specify the time periods from which data will be drawn in creating your reports.

   - The Time Period box has **Current Period** as the
default selection when the tab is opened.

- Selecting **Select Period** activates the boxes in the Alignment Periods box.

You may use the boxes to select how the data will be aligned, that is if the data has varying periodicities, you may select which periodicity will be used as the standard.

When you have finished making any modifications in the search criteria, click on the **OK** button.

B. This completes your report and displays it in the Research Insight® window display area.

There are two boxes to the left of the display area that allow you several more options.

1. The first box, **Show**, has two choices.

   You may select **Formula** or **Report**.

   Clicking on the radio button next to your selection allows you to view the report or the formulas. The display changes as you make different selections.

2. The second box, **Companies**, has four buttons near the top and a box at the bottom. The box has all the companies you selected listed. The report for each company will be displayed one at a time.

   The top two buttons, **Name** and **Ticker**, allow you to have the companies listed by name or ticker.

   The next two buttons, **Prev** and **Next**, allow you to move up and down the list of companies.

C. When you are finished working with your data you may close it by clicking on the lower of the two “Xs” in the upper right corner.

   This will prompt you to save your work. If you want to save it click on the **Yes** button.

   This will open the **Save As** window. You must save the file to your personal disk.
Library

The Library is an integral component of Research Insight® that allows you to access the textual Business Descriptions database and the latest issue available of Standard & Poor’s Trends and Projections.

There are a number of ways to start the Library. You may:

- Click on the Library icon on the Welcome screen,
- Click on the Library icon on the horizontal Main toolbar on the Research Insight® window, or
- Click on Library in the Tools drop-down menu on the Menu Bar on the Research Insight® window.

1. Once the Library is started, you are presented with the Select Company window.

Enter the company’s ticker symbol for the company you are researching in the Enter Ticker box.

If you do not know the ticker symbol you may click on the Look Up button. This opens the Look Up window where you may search for the company you are interested in researching.

- This window is similar to the Look Up window that is opened when Look Up is selected from the Tools drop-down menu on the Menu Bar except this window only has a tab for Companies instead of the four tabs of the other window (from the Tools drop-down menu).
- Click on the Paste button for the company you want to include in your research. If you are interested in more than one company you must select them one at a time.
- When you have finished selecting a company, click on Close to return to the Select Company window.

With a company ticker in the Enter Ticker box, click on the OK button.
2. This opens the Document List window.

Note: You also may see a window stating that downloads are not set up. Click the OK button and the download process will continue. However, there may be no documents available for the company you are researching.

This window has Business Description and Trends and Projections listed in the File Type box. Select, by highlighting, the File Type you want.

- Selecting Business Description opens a Notepad window with a narrative about the company you selected. Exit this window by selecting Exit from the File drop-down menu.

- Selecting Trends and Projections opens a recent issue of Trends and Projections using Adobe Acrobat. The issue displayed is the only issue available. Exit this window by selecting Exit from the File drop-down menu.

Click on OK.
Open Screen

There are two ways to start Open Screen. You may:

- Click on the Open Screen icon on the Welcome screen, or
- Click on the Open Screen icon on the vertical Research Insight® toolbar on the Research Insight® window.

1. Once Open Screen is started, you are presented with the File Open (Money Management) window with the directory tree open to S&P Screens. The files under the S&P Screens folder are the available screen files.

Select the file you want to open by highlighting it.

Click on the Finish button.

2. This opens the Research Assistant – Step 1 (Money Management) window where you may modify the screen.

Note: The “Money Management” in the window title refers to the Style being used in your research. The Style affects the way Research Insight® screens companies for your sets and the data that is displayed in the reports and charts that are produced. For more information concerning Style please go to page 45.

Note: This is the same process that you use when you access Research Assistant. For more a complete description of the features available, please go to page 6.

When you are finished making any modifications click on the Next button.

3. This opens the Research Assistant – Step 2 (Money Management) window where you may make more modifications to the screen. When you are finished click on the Next button.

4. This opens the Research Assistant – Step 3 (Money Management) window. This window gives you a number of choices. You may go to the Report Assistant, Chart Assistant, Company Highlights page or open predefined reports or charts. You may also elect to finish this project and return to the Research Insight® window.

Clicking on Report Assistant and the Next button will take you to the Report Assistant – Step 1 (Money Management) window. See page 12.
Clicking on Chart Assistant and the Next button will take you to the Chart Assistant – Step 1 (Money Management) window. See page 16.

Clicking on Open Report and the Next button will take you to the File Open (Money Management) window. See page 31.

Clicking on Open Chart and the Next button will take you to the File Open (Money Management) window. See page 33.

Clicking on Company Highlights and the Finish button will finish the search on the companies you selected and provide a Company Highlights report in the Research Insight® window display area.

Clicking on Finish and the Finish button will return you to the Research Insight® window after prompting you to save your changes. No functions will be performed on your list of companies.
Open Report

Research Insight® contains more than 100 predefined company and industry reports. These reports provide detailed financial information and include the most commonly used financial statements such as balance sheets, income statements, statements of cash flow, ratio reports and others.

There are two ways to start Open Report. You may:

- Click on the Open Report icon on the Welcome screen, or
- Click on the Open Report icon on the vertical Research Insight® toolbar on the Research Insight® window.

1. Once Open Report is started, you are presented with the File Open (Money Management) window with the directory tree open to S&P Reports. There are a number of folders and files under S&P Reports. You may further open the directory tree by clicking on the plus (+) sign next to a folder. This will reveal the reports available in that folder.

When you have selected the predefined report you want to use click on the Finish button.

2. This opens the Run Assistant (Money Management) window. You may use this window to develop the list of companies you want to include in your report. For a more complete discussion of the features of this window please go to page 21.

When you have finished developing your list of companies click on the OK button.

3. This closes the Run Assistant window and presents your report in the display area of the Research Insight® window.

There are two boxes to the left of the display area that allow you several more options.

a. The first box, Show, has two choices. You may select Formula or Report. Clicking on
the radio button next to your selection allows you to view the report or the formulas. The display changes as you make different selections.

b. The second box, Companies, has four buttons near the top and a box at the bottom. The box has all the companies you selected listed. The report for each company will be displayed one at a time.

The top two buttons, Name and Ticker, allow you to have the companies listed by name or ticker.

The next two buttons, Prev and Next, allow you to move up and down the list of companies.
Open Chart

Research Insight® includes a collection of predefined company and industry performance charts. Charts make your information easier to read and understand. They help you identify trends, make comparisons and clarify relationships.

The charts in Research Insight® may be customized to suit your needs. You may change the chart’s style, colors and axis labels.

There are two ways to start Open Chart. You may:

- Click on the Open Chart icon on the Welcome screen, or
- Click on the Open Chart icon on the vertical Research Insight® toolbar on the Research Insight® window.

1. Once Open Chart is started, you are presented with the File Open (Money Management) window with the directory tree open to S&P Charts. There are a number of folders and files under S&P Charts. You may further open the directory tree by clicking on the plus (+) sign next to a folder. This will reveal the reports available in that folder.

   When you have selected the predefined chart you want to use click on the Finish button.

2. This opens the Run Assistant (Money Management) window. You may use this window to develop the list of companies you want to include in your chart. For a more complete discussion of the features of this window please go to page 21.

   When you have finished developing your list of companies click on the OK button.

3. This closes the Run Assistant window and presents your chart in the display area of the Research Insight® window.

   There are two boxes to the left of the display area that allow you several more options.
a. The first box, **Show**, has four choices. You may select **Formula**, **Report**, **Chart**, or **Chart & Report**. Clicking on the radio button next to your selection allows you to view the chart, the report generating the chart, both the report and the chart or the formulas. The display changes as you make different selections.

b. The second box, **Companies**, has four buttons near the top and a box at the bottom. The box has all the companies you selected listed. The chart for each company will be displayed one at a time.

   The top two buttons, **Name** and **Ticker**, allow you to have the companies listed by name or ticker.

   The next two buttons, **Prev** and **Next**, allow you to move up and down the list of companies.
Open Set
Research Insight® contains a number of previously saved sets.

There are two ways to start Open Set. You may:

- Click on the Open Set icon on the Welcome screen, or
- Click on the Open Set icon on the vertical Research Insight® toolbar on the Research Insight® window.

1. Once Open Set is started, you are presented with the File Open (Money Management) window with the directory tree open to S&P Sets. If any sets have been saved, there will be files under S&P Sets.

   When you have selected the set you want to use click on the Finish button.

2. This closes the File Open window and displays the set you chose in the display area of the Research Insight® window. The set is displayed in a spreadsheet format.

   a. You may highlight a company in this set and click on the View Text icon in the Set toolbar, which appeared when your set was opened in the display area.

      Note: There may not be any documents available for the company you are researching.

      Note: Clicking on the Library icon with a company highlighted will accomplish the same function.

This opens the Document List window. You have two choices, Business Description or Trends and Projections.

1) Selecting Business Descriptions and clicking on the OK button will open a Notepad window with a text document describing the company you highlighted.

2) Selecting Trends and Projections and clicking on the OK button will open an Acrobat
Reader window with a copy of a recent Trends & Projections newsletter.

b. You may add companies to the list by clicking on the Look Up icon on the Main toolbar. This opens the Look Up window with four tabs across the top of the window. You may select a company and it added to the set displayed.

Click on the Paste button as you make selections to have them moved to the display area.

Click on the Close button when you are finished.

c. You may launch the home page of a company on your list by highlighting it and clicking on the Launch Home Page button on the Main toolbar.

This opens the Launch Company Home Page window. The company you highlighted has its ticker symbol in the data field. You may use this company or select a different company by clicking on the Look Up button.

Click on the OK button to open the home page in an Internet Explorer window.
Menu Bar

The Research Insight® Menu Bar offers the usual Windows-type menu selections. These are File, Edit, View, Databases, Tools, Window, and Help. Clicking on one of these selections will open a drop-down menu with the options available for that menu item.

File

The drop-down menu for File offers the usual options of New, Open, Save, Save As, Print, Print Setup, and Exit. Each of these operates in much the same way as any other Windows program.

The Open option provides access to the same data offered by the Open Screen, Open Report, Open Chart, and Open Set icons on the Welcome screen and the vertical Research Insight® toolbar on the Research Insight® window.

Some of the options are grayed out and cannot be accessed until there is a report or chart open in the display area.

Clicking on Classic View will cause the display area of the Research Insight® window to display a spreadsheet.

Clicking on Blank Report will bring up a blank report in the display area.

Use the Import command to import data, sets of companies, or concepts from an ASCII file into Research Insight®.

The File Options command opens the File Options window where you have the option of giving your file a description, password, or enter a note. Just above the Exit option there is a section of the drop-down menu that lists the most recent documents that have been opened. If you want to open one of these documents, click on the document and it will be opened in the display area.
Edit

The drop-down menu for Edit offers the usual options of Cut, Copy, Paste, Delete, Find, Find Next, Find Previous, and Replace. These all operate in a similar manner to other windows programs.

The Paste Formula command is used to insert formulas into a report or worksheet you may be working on. Hovering the mouse pointer over, or clicking on, Paste Formula opens another drop-down menu with four choices, Function, Item, Company, and Set.

1. Clicking on any of these four choices opens the Look Up window. This window performs a function similar to the various Look Up icons located on many of the windows throughout Research Insight®.

The Look Up window has four tabs across the top, with the same four choices as the drop-down menu. You may choose other categories than the one you used to open the window.

Each tab has two main boxes. The one on the left is the Select Company Category and the box on the right is Select Companies. The names of these boxes change to reflect the name of the tab chosen (e.g., Company, Item, Function, or Set).

2. To select a company (function, etc.) highlight the company category you want in the Select Company Category box. The list in the Select Companies box changes as each category is selected.

3. Then select one or more companies from the Select Companies box.

To select a company, you may either double click on the company and it will be moved to the Research Insight® window display area or highlight a company and click on the Paste button in the Lookup window to move the company to the Research Insight® window.

The Select Companies box has a box above it where you may enter words or parts of words. As characters are typed into the box the list scrolls to the nearest match.

There is another box at the bottom of the Select Companies box that shows the ticker for any company that is highlighted. For the other tabs this box shows a definition or other information concerning the highlighted term.

4. Each of the four tabs has the Paste button as well as a Copy to Clipboard button that will move the designated information to the clipboard.
5. Each of the tabs has a third button that changes according to which tab is selected.
   a. The **Companies** tab has a **Segments** button.
      - To use this button, highlight a company in the **Select Companies** box in the **Lookup** window and click the **Segments** button.
      - This opens the **Segments** window. This window has choices for three types of segments **Business**, **Issue**, or **Geographic**.
      - Clicking the radio button next to the type of segment changes the list presented in the box next to the segment choices.
      - To select a term to move to the **Research Insight®** window, highlight the term and click on the **Paste** button, or the **Copy to Clipboard** button.
      - When the **Geographic** radio button is selected a third button appears. This button, the **Description** button, opens the **Dialog** window that has a list of the geographic codes listed in the display box and identifies the area each code is associated with.
   b. The **Items** and **Functions** tabs both have a **Definition** button as the third button.
      - To use the **Definition** button, highlight the term you want to have defined in the **Select Items** or **Select Functions** box. Then click on the **Definitions** button.
      - This opens the **Compustat North America Data and Reference** window. The term you highlighted is displayed in the window along with its definition.
      - When you have finished with this window you may close it by clicking on the “x” in the upper right corner.
c. The **Sets** tab has a **Browse** button as its third button.

This button opens the *Open* window. You may not save files to the network drive so all saved sets have to be stored on removable media.

In the **Look In** box, click on the down arrow and select the drive you need from the list.

Once you have selected the drive you need, all sets will be listed.

To choose the one you want, highlight it and click on **Open**.

6. All four tabs also have a **Find Text** box near the bottom to search for specific terms in which you may have an interest. You may type in a whole company name or a part of a name. The list in the **Select Companies** (or Functions, etc.) box will scroll to the closest match when the **Find Next** button is pressed.
View

The drop-down menu for View offers you the choice of selecting a Toolbars submenu or the Status Bar. The selections in the Toolbars drop-down menu (Main, Research Insight, Report Formula, Report Results, Set, and Library) and Status Bar are toggle selections. That is, you may click on any of these selections to turn on or turn off whether or not these toolbars are displayed.

Note: The Library selection is always grayed out with a grayed out checkmark. This toolbar is controlled by the Main toolbar selection.

The Main toolbar is the row of icons that runs horizontally across the Research Insight® window below the Menu Bar.

The Research Insight toolbar is the vertical row of icons along the left side of the Research Insight® window.

The Report Formula toolbar is a row of six icons that, if selected to appear on the toolbar, is grayed out when it is not in use. The icons on this toolbar are Select, Add Text, Add Formula, Add Table, Chart Definition, and Rerun Assistant. When Formula is selected in the Show box (this box appears on the left side of the display area when a report is opened and contains selections to display the report or formulas), when a report is displayed in the display area, this toolbar automatically appears with pertinent icons activated.

Note: If an icon appears in more than one toolbar, it performs the same function in each toolbar.

The Report Results toolbar is a row of four icons that, if selected to appear on the toolbar, is grayed out when it is not in use. The icons on this toolbar are View Company, Chart Definition, View Text, and Rerun Assistant. When a report is displayed in the display area this toolbar automatically appears with pertinent icons activated.

The Set toolbar is a single icon that, if selected to appear on the toolbar, is grayed out when it is not in use. This icon is the View Text icon. When a set is displayed in the display area this toolbar automatically appears.

Status Bar turns the status bar at the bottom of the Research Insight® window on and off. It provides a variety of information. For instance, it indicates which database is being used (COMPUSTAT® or CLASSIC). When a set has been opened the Status Bar lists the number of lines in the spreadsheet (e.g., Set size = 1037 indicates there are 1037 lines of data).
Databases

The drop-down menu for Databases offers you the following choices: Default Database, View/Modify Data, Database Group, Concept, Description, Company, Currency, and Item.

Default Database

- Clicking on Default Database opens the Default Database Group window.
- Clicking on the down arrow button next to the data window displays a list of databases that are available. You have a choice of Back Data, CLASSIC, COMPUSTAT, COMPUSTATPIT, and GLOBALVantage.
- Choose the database you want by clicking on it. It will appear in the data window of the Default Database Group window.
- Click OK and the chosen database will be made the default database for Research Insight®. This is reflected by the name of the database that appears in the lower right corner of the screen in the Status Bar.

View/Modify Data

1. Clicking on View/Modify Data opens the View/Modify Data window. This window has three data fields Item, Companies, and Sets. The Look Up button to the right of these fields works with all three fields, depending on which field has the cursor active in it.
   - Enter the mnemonic or use the Look Up button to search for a specific item and paste it into the Item data field.
   - Select one or more companies or select a set.
   - Click the View button to view and modify data values for the specified company or set.

2. The Calculate button in the View/Modify Data window lets you assign or edit data values to be calculated from existing items, concepts, and values.

   Clicking on the Calculate button opens the Calculate Data window where you can enter the formula and the time period or range of periods for which you want to calculate values.

   A formula is created by typing a data string into the formula box. For example, the following sample taken from the Research Insight® help information
calculates average sales over the last five years. \texttt{@PAVG} is a function, \texttt{SALE} is an item, and \texttt{Y91} and \texttt{Y95} are time period references.

\texttt{@PAVG(SALE,Y91,Y95)}

3. The Restore button in the View/Modify Data window opens the Restore Data window where you can restore data for a selected company/set or for all the companies in the database.

   - To restore one company or set, click on the Selected Company/Set radio button. You must enter a time period when you are working with a specific company or set.
   - To restore all companies, click on the All Companies radio button.

     When All Companies is selected you have the choice of restoring all periods or entering a specific time period.

     Click on either the All Periods or Select radio buttons. Enter the time periods you want if required.

   - To complete the restore operation click on the Restore button in the Restore Data window.

Database Group

1. Clicking on Database Group opens the Database Group window. This window consists of five data fields with drop-down menus. These data fields are:

   - Active Databases – this lists all the databases that are active. When CLASSIC is selected as the default database it is included in this field.
   - Write-To Database – allows you to chose which database is being written to when you modify data.
   - On-Line Database and Classic On-Line Database does not apply to the Business Library because this site is not licensed for any online Research Insight® options.
   - Database Group – allows you to select which database (Back Data, CLASSIC, COMPUSTAT, COMPUSTATPIT, and GLOBALVantage) is used by Research Insight®.

2. When you have finished making your selections click on Accept to have your changes applied to the databases and return to the Research Insight® window.

Concept, Description, Company, Currency (when it is not grayed out), and Item

These selections open windows that allow you to edit Concepts, Descriptions, Companies or Items.
Tools

The drop-down menu for **Tools** offers you an alternative method of accessing the various Research Insight® assistants. This method is helpful if you have selected to hide the various toolbars of icons. The options available to you under **Tools** are **Research Assistant; Report Assistant; Chart Assistant; Look Up; Company Highlights; Library; Market Insight; Company Home Page; Task Scheduler; Export Concepts; Customize; Options;** and **Support Files.**

**Research Assistant, Report Assistant, Chart Assistant, Company Highlights, and Library**

These selections link you to the same functions as the icons on the *Welcome* screen and the toolbars on the *Research Insight®* window.

**Look Up**

The **Look Up** selection links you to a *Look Up* window that performs a similar function to the various *Look Up* icons located on many of the windows throughout Research Insight®.

*Look Up* may also be accessed from the *Look Up* icon on the Main toolbar.

This is the same *Look Up* window opened when **Paste Formula** is selected from the drop-down menu under **Edit** on the Menu Bar. (See page 38.)

**Company Home Page**

Selecting **Company Home Page** opens the *Launch Company Home Page* window. Using this window you may type in or select the ticker symbol of a company you are interested in and Research Insight® will open that company’s home page, if it is available, when you click **OK.**

**Company Home Page** may also be accessed from the **Launch Home Page** icon on the Main toolbar.

**Export Concepts**

Selecting **Export Concepts** opens the *Export Concepts* window. Clicking on the Non-User check box near the bottom of the page will populate the **From:** box on the left with a list of concepts.

Concepts are selected by highlighting them and clicking on the **Add** button. This will move them into the **To:** box.

Clicking on the **Accept** button will open the *Save As* window where you are prompted to select a location and name the file.
The saved files may be opened using WordPad or Word.

**Task Scheduler and Customize**

These selections offer various methods of customizing Research Insight®. Since this program is installed on a server and accessed by many users these options should not be utilized as information needed by other users may be hidden depending on the options selected.

**Market Insight**

Market Insight is not part of the Business Library’s subscription.

**Options**

This selection allows you to select various options to make Research Insight® fit your needs.

Clicking on **Options** opens the Options window, which has eight tabs across the top. These tabs are Report, Styles, Adjustment Factors, Data Code Settings, Period Reference, Screening, Internet, and License. Styles is particularly important as described below.

**Styles**

The Styles tab allows you to select from four Styles (Corporate Finance, Credit, Money Management, and Transfer Pricing).

These styles affect the basic operation of Research Insight®. When you are using Research Assistant (or Report Assistant or Chart Assistant) the Style is indicated in the window title (i.e., Research Assistant – Step 1 (Money Management)).

Each Style contains different collections of Indicators and Items. The Indicators affect the way Research Insight® screens its databases for companies. The Items affect the data that is displayed in the reports and charts that are produced.

You may view the Indicator Groups and Indicators available in the Style being used by clicking on the **Indicator Groups** button in the Customize section of the Styles tab.

This will open the Custom Indicator Groups window. See page 10 for information about this window.
The same is true for the Items and Item Groups. These are viewable by clicking on the Item Groups button in the Customize section of the Styles tab.

This will open the Custom Item Groups window. See page 13 for information about this window.

**Changing the Style in Research Insight®**

1. You may change the Style by selecting **Options** from the **Tools** drop-down menu.
2. Click on the **Styles** tab. The Style currently being used is listed in the **Active Style** box.
3. The Styles that are available are listed in the Styles box. Select the Style you want to use by highlighting it and click on the **Set Active Style** button.
4. This causes your selected Style to be listed in the **Active Style** box and the **Apply** button to become activated.
5. Click on the **Apply** button to have the new Style applied to the various Assistants in Research Insight®.
6. Click on the **OK** button to close the **Options** window and return to the **Research Insight®** window.

**Support Files**

The **Support Files** selection will open a tool that is used to update the various files Research Insight® uses to perform many of its functions. This tool is used by administrative personnel.
**Window**

The drop-down menu for *Window* is grayed out until there is information presented in the display area. Once information is displayed, the options in the drop-down menu are activated and may be used to arrange how the information is displayed.

If more than one database is open each is listed at the bottom of the drop-down menu. You may switch from one database to another by clicking on the various database filenames in the *Window* drop-down menu.

The options allow you to arrange the databases in a number of ways. The options are *Cascade*, *Tile Vertically*, *Tile Horizontally*, *Arrange Icons*, and *Close All*.

![Window drop-down menu and database interface](image)
Help

The drop-down menu for Help offers you a variety of help features. These include Research Insight Help Topics, Data and Reference, FAQs, S&P on the Web, Other Compustat Products, Welcome to Research Insight, and About Research Insight.

Research Insight Help Topics

Clicking on Research Insight Help Topics opens the Research Insight Help window. This window has three tabs Contents, Index and Search.

- **Contents** tab – works as a table of contents, displaying a list of available topics in on-line help.
- **Index** tab – lets you search the index for a topic.
- **Search** tab – lets you perform a full-text search for a word or phrase.

Data and Reference

Clicking on Data and Reference opens the Compustat North America Data and Reference window. This window displays item and concept definitions.

This window functions in a similar manner to the Help Topics window above.
FAQs

Clicking on FAQs opens the Frequently Asked Questions window. This window provides a list of the most frequently asked questions about Research Insight®, including specific examples on screening, reporting, formulas and other applications.

S&P on the Web

Clicking on S&P on the Web opens a drop-down menu with more selections. These include Market Insight, Index Services, Online Support, and S&P Home Page.

- Market Insight, Index Services, and Online Support – These selections are not included in the current program.
- S&P Home Page – This opens S&P’s Equity Research page where you are provided information concerning S&P’s Equity Research product.
Other Compustat Products

Clicking on Other Compustat Products opens the S&P Home page.

Welcome to Research Insight

Clicking on Welcome to Research Insight opens the Research Insight® Welcome Screen. (See page 5.)

About Research Insight

Clicking on About Research Insight displays version and copyright information for Research Insight®.
Definitions

Company References

Company references allows you to attach a company’s ticker to a formula so that Research Insight® will refer to that company’s data. When you include a company reference in a formula, you are telling Research Insight® to retrieve or calculate that data for a specific company only, regardless of other companies or sets that may be included in your screen, report, chart, or spreadsheet.

Concepts

Concepts are mathematical or logical combinations of items and/or other concepts. They are generally used to save time and increase accuracy when manipulating data in routine, repetitious, or complex expressions. Concepts do not contain values. They are mathematical calculations that are reevaluated each time you use them. While Research Insight® contains more than 300 concepts, there may be times when you will want to create your own concept for your financial analysis. Research Insight® allows you to modify existing concepts or create a new concept.

Functions

A Function is a predefined calculation. Functions can contain a combination of items, concepts, companies, time period references, and other functions. Each function begins with the @ symbol and is followed by a short name. Each function also includes an argument. Arguments tell Research Insight® which variables to evaluate, enabling you to tailor each function for your specific needs.

Items

An Item is a piece of information collected and stored in a database. Each item is identified by a descriptive name and a mnemonic (abbreviated name). Research Insight® contains hundreds of data items covering an array of fundamental financial and market information.

Predefined Sets

Research Insight® has many different predefined sets for different types of data. These are referred to as dollar sign ($) sets. The available $ sets are listed in the table on the next page.

Note: In Research Insight® COMPUSTAT® the abbreviation CS refers to the COMPUSTAT® (North America) database.
<table>
<thead>
<tr>
<th>S Set</th>
<th>Description</th>
<th>What it Contains</th>
</tr>
</thead>
<tbody>
<tr>
<td>SA</td>
<td>CS Aggregate</td>
<td>The full range of aggregated entities in the historical GICS series</td>
</tr>
<tr>
<td>SADR</td>
<td>ADR/ADS Companies</td>
<td>Non-U.S. Companies trading American Depository Receipts/Shares</td>
</tr>
<tr>
<td>SC</td>
<td>CS Active</td>
<td>Active U.S. company data</td>
</tr>
<tr>
<td>SCG</td>
<td>CS Geographic Segment</td>
<td>Geographic segment data for active U.S. companies</td>
</tr>
<tr>
<td>SCI</td>
<td>CS Active Issue</td>
<td>Issue data for active U.S. companies</td>
</tr>
<tr>
<td>SCS</td>
<td>CS Business Segment</td>
<td>Business segment data for active U.S. companies</td>
</tr>
<tr>
<td>SETF</td>
<td>Exchange Traded Funds</td>
<td>Listing of exchange-traded funds</td>
</tr>
<tr>
<td>SFORTUNE500</td>
<td>Fortune Set</td>
<td>Includes public companies on the Fortune 500 list</td>
</tr>
<tr>
<td>SI</td>
<td>CS Indexes – Active and Research</td>
<td>Market data for active and inactive indexes</td>
</tr>
<tr>
<td>SII</td>
<td>CS Index Issue</td>
<td>Index data for stock issues</td>
</tr>
<tr>
<td>$NAS_100</td>
<td>NASDAQ 100 Index</td>
<td>All companies in the NASDAQ 100 Index</td>
</tr>
<tr>
<td>$NAS_FINL</td>
<td>NASDAQ Financials Index</td>
<td>All companies in the NASDAQ Financials Index</td>
</tr>
<tr>
<td>$R</td>
<td>CS Research</td>
<td>Inactive U.S. companies</td>
</tr>
<tr>
<td>SRI</td>
<td>CS Research Issue</td>
<td>Issue data for inactive U.S. companies</td>
</tr>
<tr>
<td>SPCI_IG</td>
<td>S&amp;P Industrial Investment Grade Credit Index</td>
<td>Daily credit spread levels within the U.S. industrial investment grade rating spectrum</td>
</tr>
<tr>
<td>SPCI_SG</td>
<td>S&amp;P Industrial Speculative Grade Credit Index</td>
<td>Daily credit spread levels within the U.S. industrial speculative grade rating spectrum</td>
</tr>
<tr>
<td>$SP_100</td>
<td>S&amp;P 100 Index</td>
<td>All companies in the S&amp;P 100 Index</td>
</tr>
<tr>
<td>$SP400CG</td>
<td>Citigroup Growth - SP400</td>
<td>Includes broad coverage of growth stocks in the S&amp;P 400; constituents are weighted by market cap.</td>
</tr>
<tr>
<td>$SP400CPG</td>
<td>Citigroup Pure Growth - SP400</td>
<td>Includes only pure growth companies from the S&amp;P 400 Index; constituents are weighted by style scores.</td>
</tr>
<tr>
<td>$SP400CPV</td>
<td>Citigroup Pure Value - SP400</td>
<td>Includes only pure value companies from the S&amp;P 400 Index; constituents are weighted by style scores.</td>
</tr>
<tr>
<td>$SP400CV</td>
<td>Citigroup Value - SP400</td>
<td>Includes broad coverage of value stocks in the S&amp;P 400; constituents are weighted by market cap.</td>
</tr>
<tr>
<td>$SP_500</td>
<td>S&amp;P 500 Index</td>
<td>All companies in the S&amp;P 500 Index</td>
</tr>
<tr>
<td>$SP500CG</td>
<td>Citigroup Growth - SP500</td>
<td>Includes broad coverage of growth stocks in the S&amp;P 500; constituents are weighted by market cap.</td>
</tr>
<tr>
<td>$SP500CPG</td>
<td>Citigroup Pure Growth - SP500</td>
<td>Includes only pure growth companies from the S&amp;P 500 Index; constituents are weighted by style scores.</td>
</tr>
<tr>
<td>$SP500CPV</td>
<td>Citigroup Pure Value - SP500</td>
<td>Includes only pure value companies from the S&amp;P 500 Index; constituents are weighted by style scores.</td>
</tr>
<tr>
<td>$SP500CV</td>
<td>Citigroup Value - SP500</td>
<td>Includes broad coverage of value stocks in the S&amp;P 500; constituents are weighted by market cap.</td>
</tr>
<tr>
<td>$SP600CG</td>
<td>Citigroup Growth - SP600</td>
<td>Includes broad coverage of growth stocks in the S&amp;P 600; constituents are weighted by market cap.</td>
</tr>
<tr>
<td>$SP600CPG</td>
<td>Citigroup Pure Growth - SP600</td>
<td>Includes only pure growth companies from the S&amp;P 600 Index; constituents are weighted by style scores.</td>
</tr>
<tr>
<td>$SP600CPV</td>
<td>Citigroup Pure Value - SP600</td>
<td>Includes only pure value companies from the S&amp;P 600 Index; constituents are weighted by style scores.</td>
</tr>
<tr>
<td>$SP600CV</td>
<td>Citigroup Value - SP600</td>
<td>Includes broad coverage of value stocks in the S&amp;P 600; constituents are weighted by market cap.</td>
</tr>
<tr>
<td>$SP_GICS</td>
<td>S&amp;P Global Industry Classification Standard</td>
<td>All industries in the S&amp;P Global Industry Classification Standard</td>
</tr>
<tr>
<td>$SP_Mid</td>
<td>S&amp;P MidCap 400 Index</td>
<td>All companies in the S&amp;P MidCap 400 Index</td>
</tr>
<tr>
<td>$SP_Small</td>
<td>S&amp;P SmallCap 600 Index</td>
<td>All companies in the S&amp;P SmallCap 600 Index</td>
</tr>
<tr>
<td>$SP_Super</td>
<td>S&amp;P 1500 Super Composite Index</td>
<td>All companies in the S&amp;P Super Composite Index, comprised of the S&amp;P 500, MidCap 400, and SmallCap 600 Indexes.</td>
</tr>
<tr>
<td>$T</td>
<td>Canadian Active</td>
<td>Canadian company data displayed in Canadian currency</td>
</tr>
<tr>
<td>$TI</td>
<td>Canadian Issue</td>
<td>Issue data for active Canadian companies</td>
</tr>
<tr>
<td>$TR</td>
<td>Canadian Research</td>
<td>Inactive Canadian companies</td>
</tr>
<tr>
<td>STSE100I</td>
<td>Toronto Stock Exchange 100</td>
<td>All companies in the Toronto Stock Exchange 100</td>
</tr>
<tr>
<td>STSE200I</td>
<td>Toronto Stock Exchange 200</td>
<td>All companies in the Toronto Stock Exchange 200</td>
</tr>
<tr>
<td>STSE300I</td>
<td>Toronto Stock Exchange 300</td>
<td>All companies in the Toronto Stock Exchange 300</td>
</tr>
</tbody>
</table>
Sets

A Set is a collection of companies, segments, issues, or currencies that share a common attribute. Research Insight® provides many Predefined Sets for different types of data. You can also create a set in several ways: when you screen the database, the companies that meet your criteria can be saved as a set; you can create a set from a list of companies; and you can use the @SET function to create a set. In Research Insight® the set name is preceded by a dollar sign ($).

Time Period References

A time period reference tells Research Insight® to retrieve a data value for a particular point in time other than the current period. If you do not include time period references in your formulas, Research Insight® automatically uses the current period (or the most recently available data).
Using the Research Insight Add-In for Excel

The Research Insight Add-In enables you to access Research Insight data within Microsoft Excel. It allows you to pull data directly into Excel spreadsheets, with the column headings displayed. The information is already in Excel format and may be manipulated and saved much easier than in the regular Research Insight display.

Accessing Microsoft Excel

To access Excel you must be logged onto the Mason School of Business network. With the network screen displayed, click on the Start button in the lower left corner of the screen.

Move your mouse pointer up the list of selections and click on Microsoft Office. This will open the sub-menu for this selection.

Click on Microsoft Office Excel to open the Excel program.

There is also an Excel icon on the desktop display of each computer in the McLeod Business Library.

When the program is finished loading, the Research Insight links are included in the Add-Ins tab in the menu bar.

The Research Insight tool bar is displayed in the Custom Toolbars section of the Add-Ins tab.

The tool bar includes five buttons (some installations may only have the first two buttons): S&P Research Insight Wizards, S&P Look Up List, S&P Run Assistant, Unlink Arrays, and Batch Print Charts and Reports.
Finding the Research Insight Welcome Screen

The easiest way to access the information in Research Insight is to open the Welcome Screen. You may do this two ways:

1. Click on the S&P Research Insight Wizards button on the tool bar, or
2. Select Welcome to Research Insight in the S&P menu located in the Menu Commands section of the Add-Ins tab.

Either of these will open the Welcome to Research Insight screen.

Once you have opened this screen, the Research Insight program performs very similarly to the Research Insight program accessed through the Business Library databases network.

Research Insight Assistants and Predefined Reports, Charts and Templates

- Information about running the Research Assistant may be found on page 6.

Note: When results that require one page per company are presented in Excel the Research Insight tool bar changes to include a small data field with the number of companies in the set (e.g., Set Size = 640).

To display another company, click on the down arrow. This will open a menu with the current company highlighted. You may scroll down the list and click on another company to have its information displayed in the chart.
- Information about running the **Report Assistant** may be found on page 12.
- Information about running the **Chart Assistant** may be found on page 16.
- Information about running **Open Screen** may be found on page 29.
- Information about running **Open Report** may be found on page 31.
- Information about running **Open Chart** may be found on page 33.
- Information about running **Run Assistant** may be found on page 21.

**Open Template**

To start **Open Template** select **Open Template** in the S&P menu.

1. Once Open Template is started, you are presented with the **File Open (Money Management)** window with the directory tree open to S&P Excel Templates. There are a number of folders and files under Company Fun-
damental Analysis Templates. You may further open the directory tree by clicking on the plus (+) sign next to a folder. This will reveal the reports available in that folder.

When you have selected the predefined report you want to use click on the **Finish** button.

2. Depending on the template selected you will be presented with a *Microsoft Excel* window warning you that the workbook contains links to other data sources and are given the choice of updating or not updating the data. Click on the **Update** button and the window will close and the template will be opened in Excel.

The template may be an active one in which you may select other companies to display by changing the ticker and pressing the **Enter** key.

Some templates may display a help screen. This is only the first page of the template. Clicking on the sheet tabs at the bottom of the page (i.e., Annual, Quarterly) will open the data sheets included in the template.

To load other companies use the Run Assistant.
Other Functions

Information about Look Up List may be found on page 38.

The **Break Arrays** selection in the **S&P** menu will cause the report displayed in Excel to be separated from the Research Insight source of data. The report may no longer be updated, and if other companies were available for display, they will no longer be available and the company presently being displayed will be the only one available.

Notes

**Results Loading.** The Research Insight add-in takes some time to load the information into Excel once the **Finish** button is clicked on in the various assistants. The time to load the information varies and may take 30 seconds to more than a minute, depending on the amount of data to process.

**Styles.** When the Research Assistant is opened it will already have a “style” (e.g., Money Management, Corporate Finance, etc.) in place. In order to change the style you will have to open the Research Insight program from the **All Programs/Research Insight** menu under the Start button on the Business Library database network screen. Please go to page 45 for more information about Styles.

**Saving Results.** If you want to save your results, you must use your personal removable media device.